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Quick Start

Program Installation: If the RAMAG software has not been installed yet, follow the
instructions in Section 2.4.

Starting the program: assumes that the software was installed on drive C: in a folder
called RAMAG2.

Using Windows Explorer:

1. Navigate to the c:\ramag2  folder 
2. Double click  RAMAG2.EXE  to start the program

Using the Windows Start button:

1. From the Windows desktop, click the Start button, then Run
2. Type   c:\ramag2\ramag2.exe and press <Enter> or click OK

Step Description

  1 Load a Wadi data file (.WAD) by selecting [Data] / [Load File] from the Main
Menu. Then choose which profile to read.

  2 Select [Data] / [Set Data Units] and enter distance units (feet or meters). Only
the first letter “ f ” or “m” is used. Feet is the default when the program begins
for the first time.

  3 Set filter depth by selecting [Plot] / [Set Filter Depth]. Maximum depth allowed
is 100 units (feet or meters).  

  4 To plot a line graph of the raw unfiltered data, select [Plot] / [Unfiltered Data]

  5 To print the unfiltered line graph, select [File] / [Print Setup] from the graph
window menu. Choose which printer to use if more than one is installed. You
can also choose page orientation (portrait or landscape) and other properties
available through the Windows Printer driver. To print the graph, select [File]
/ [Print Selected Graph].

  6 If you want to re-scale the graph to a different size, click on the graph
selector button (red square) in the upper right corner of the graph window or
select [Graphs] / [Parameters] from the graph menu. Change the graph width
and height values in the Graph Parameters dialog box. For example, to make
the graph 50% of it original size change the width and height to 50%. To
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make the graph fill the entire page when printed, select [File] / [Print Options]
and choose [Print graphs to max size] in the Print Style grouping.

  7 To close the graph window, select [Close Graph] / [Close].

  8 To plot a filtered line graph, select [Plot] / [Filtered Data].

  9 To plot a filtered current density cross section, select [Plot] / [Cross Section].
Maximum length is 300 data units (feet or meters). Cross sections are
displayed in color by default. If grey scale is preferred, select [Plot] / [Set
Color]. Filtered in-phase (real) data is also the default. If both in-phase and
quadrature (imaginary) is desired, select [Plot] / [Set Plot Type] and choose
both by entering “2".

 10 To save line graphs or cross sections as Windows bitmap files (.BMP), select
[Save] / [Filename] from the Main Menu. After entering a filename for the
bitmap, select [Save] / [Save As .BMP] to save the contents of the graph
window.

 11 If you want to explore the interactive graphics design capabilities built into
RAMAG, see Section 5.0 Interactive Graph Design or run the Tutorial in
Section 6.0.

 12 To end the program, select [Quit] / [Quit Program].
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1. Introduction

In geophysical VLF work, it is the magnetic component of the electro-magnetic field from
distant radio transmitters that is used. RAMAG stands for radiomagnetics and it is software
designed for the planning of a VLF survey and for the interpretation of recorded
geophysical VLF data. In this application, VLF stands for very low frequency referring to
transmitters in the range of 15-30 kHz.

1.1 Program description

RAMAG transfers data from the Abem Wadi and transforms field data into line graphs of
original (raw) or filtered data in either single profile or multi-profile format. Graphs can be
scaled to any size supported by the currently installed printer. A current density cross
section can also be produced in color or grey scale. 

All graphs, except the multi-profile plot, can be completely customized by using the
interactive editing tools that are built into the software. Graph components such as text
labels and fonts, X and Y axes, axis labels and ticks, line attributes (thickness, color, solid,
dashed etc.), spline smoothing, and data point symbols are examples of features that can
be edited and changed by the user while the graph is on screen. However, an internal set
of default parameters will always produce a good looking graph on an 8.5x11 page without
using the interactive options. Line graphs and cross sections can be saved as Windows
bitmap (.BMP) files. This allows the saved files to imported into other graphics programs
or word processors for additonal annotation or for inclusion with text documents.

The linear filtering process used herein is based on the Karous and Hjelt algorithm
published in 1983. This filtering algorithm has been combined with a weighted running
average smoothing function.

A survey planning module is accessed by selecting [Transmitters/Locate] from the Main
Menu. The Survey Planner has input boxes for entering the latitude, longitude and local
time zone of the proposed survey site. The program then searches a database and
produces a listing of all transmitters within 7000 km radius. For each transmitter found, the
listing provides the distance in km, the bearing relative to true North, the effective
transmitting range and the off-air schedule in local time (if known).

This manual assumes that the user is familiar with the VLF surveying method and is
knowledgeable on how to apply and interpret the graphical results produced by this
software. For those who need a review or some additional guidance, please refer to the
Abem Interpretation Guide - Theory, practice and case stories for Wadi operators issued
by Abem Instruments.
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1.2 Warranty

The author has performed a variety of quality control tests using various computers,
processors, and output devices to ensure that the RAMAG software and the Instruction
Manual are free from errors. However, the author does not assume any responsibility for
results obtained using this software.

No warranty is granted by the author regarding the RAMAG software or its fitness for a
particular use or purpose. The author assumes no responsibility for steps that are either
taken or not taken as the result of decisions based on the use of the RAMAG software. The
author is not liable for any lost revenues or profits which may result from the use, or
inability to use this software.

It is the user's responsibility to make sure that the interpretation derived from the use of this
software is accurate and correct.

2. Software Installation

2.1 The RAMAG distribution disk

The software is provided on CD-ROM and contains the following 14 files: 

RAMAG2.EXE SETUP.EXE 
VBHOOKR3.DLL SPI721.EXE 
WCT32FR3.DLL WADIDL.EXE
WTZ.FRX SAXCOMM.OCA
MSVBVM50.DLL SAXCOMM.OCX
EXAMPLE1.WAD AUXDB.DAT                     
EXAMPLE2.WAD MANUAL2.PDF                     

MANUAL2.PDF is an Adobe Acrobat PDF version of the hard copy Instruction Manual. It
can be viewed on screen using Adobe Acrobat Reader Version 4 or later.  It is usually
bundled as part of the Windows operating system. A free copy can also be obtained
directly from Adobe.

2.2 Hardware requirements

To use the RAMAG Version 2.2 - USB software you will need a computer with one of the
following Microsoft Windows operating systems:  2000 or XP. The computer monitor and
graphics card should  be capable of standard SVGA resolutions. A USB port must be
available for the software protection key (USB dongle). Graphics will be output to the
current active Windows printer.
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2.3 Software limitations

Maximum number of profiles within a data set is limited to 10.
Maximum number of data points per profile is limited to 400.
Current density cross sections can not exceed 300 distance units in length.

2.4 To install the RAMAG software

Important Notes:

–> Do not plug in the USB hardware key (dongle) until after the software is installed.

–> Installing a USB device driver with Windows 2000 or XP requires that the user be    
logged in to an account with administrator privileges. To check your account status     
follow these steps: click Start > Control Panel, then double-click the User Accounts icon.
                                                                                                                                          

To install the RAMAG software on your computer, proceed as follows:

1. Create a folder(directory) on the C: drive called RAMAG2. Other drives such as D: can
    also be used.
2. Copy all 14 files on the CD-ROM to the C:\RAMAG2  folder.  
3. Create a folder named VLFDATA and copy the example data files EXAMPLE1.WAD 
     and EXAMPLE2.WAD and any other field data files (*.WAD) to this folder. This will   
     speed up the process of loading data into memory because the default search path is
     c:\vlfdata\
4. From the RAMAG2 folder, run the set up program by double clicking SETUP.EXE or  
     choose the “Run” command from the Start Menu and type c:\ramag2\setup.exe. Once
    the set up program has started, click the Install button. The installation process is      
    completely automated and requires no input from the user. Click Exit when finished.
5. Plug in the USB hardware key. A message will indicate that New Hardware has been 
    found and is installed and ready to use. Installation is now complete.

2.5 Starting the software

The following two examples assume that the software was loaded onto drive C: in a folder
(directory) called Ramag2.

Using Windows Explorer:

1. Navigate to the C:\Ramag2 folder 
2. Double click the RAMAG2.EXE  file to start the program
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Using the Windows Start button:

1. From the Windows desktop, click the Start button, then Run
2. Type   c:\ramag2\ramag2.exe and press <Enter> or click OK

2.6 Uninstall the software

To uninstall the software, click the Start button > Control Panel > Add or Remove Programs
Highlight the Sentinel Protection Installer 7.2.1, then select Remove.

3. Main Program Menu

Upon starting the software, the Main pull-down menu headings shown below will be
displayed at the top of the window. This screen is the primary RAMAG work space.

Data     Plot     Save     Transmitters Wadi     CloseGraph     Quit

3.1 Data

3.1.1 Load File ............. Select a VLF data file and a particular profile within that data
set for display and processing. If you are loading an edited data
file, make sure there are no blank lines at the end of the file.
Blank lines will produce an “Input past end of file” error.

3.1.2 Change Profile.... Select a new profile for processing.

3.1.3 Data Info ............ Display the data information screen. This is useful for
reviewing a data set and for selecting X-axis limits for
current density cross sections.

3.1.4 Set Default Folder Select a new default folder for retreiving data files. When
RAMAG starts, it looks for c:\vlfdata. If data is stored in another
folder, use this menu option to reset the default. 

3.1.5 Set Data Units ........ Set the distance units to feet (default) or meters. Upon exiting
the program, the data units currently in use will be saved and
automatically reloaded the next time the program is started.

3.2 Plot

The first three menu items will allow the user to plot line graphs or a multi-profile line graph
in an X - Y axis format. The X axis is displayed in distance units (feet or meters). The data
units for the Y axis is In-phase (%). This is the percentage of the total in-phase response
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produced by the subsurface conductor (anomaly). Quadrature refers to the out-of-phase
response measurement. Note: In the Wadi Instruction Manual, the terms Real and
Imaginary are used to represent the In-phase and Quadrature measurements, respectively.

3.2.1 Unfiltered Data ... Plot a line graph of raw unfiltered data

3.2.2 Filtered Data....... Plot a line graph of filtered data. The Y axis is the output from
the Karous Hjelt filter operator. Units are % In-phase.

3.2.3 Multi-Profile ....... Displays the Multi-Profile window. The Graph button 
produces a filtered graph of every profile in the data file
using a filter depth = 60 ft or the value set in 3.2.5. If 
profiles are clipped along the Y-axis, increase the Y-axis
limits (%) using the New Scale button. Default is -30 30.
The Print button sends the Multi-Profile plot to the currently
installed printer. The Exit button clears the plot window and
returns to the Main Menu window.

3.2.4 Cross Section.... Displays the X-axis Limits input box for current density cross
sections. X-axis length cannot exceed 300 distance units,
(default is 0 to 250). A color cross section is displayed by
default. If a grey scale image is preferred see 3.2.6 Set Color.
Values along the color bar are In-phase (%) which represents
the approximate percentage of the total In-phase signal being
produced by the subsurface conductor.

3.2.5 Set Filter Depth... Sets the filter depth for line graphs, multi-profile plots, and
current density cross sections. Default = 60 (feet or meters).
Maximum depth allowed is 100.

3.2.6 Set Color ..... Sets the color scheme (color or shades of grey) for current
density cross sections. Default is color. Select grey for output
on non-color printers.

3.2.7 Set Plot Type Allows the user to select the type of current density cross
section to plot. Enter 1 for in-phase only or 2 for both in-phase
and quadrature. Default is in-phase only. 

3.3 Save

This menu item allows the on screen graphics (line graphs and cross sections) to be saved
as Windows bitmap files.
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3.3.1 File name Enter a file name for the bitmap file to be saved. Include 
drive:\folder\filename if you want to save it to a different folder.
Use the .BMP file extension.

3.3.2 Save As .BMP Saves the file using the specified file name.

3.4 Transmitters

This is the entry point to the VLF survey planning module. After entering the longitude,
latitude, and local time zone of the survey site, the program will list suitable VLF
transmitters, distance to the transmitters and approximate range of the transmitter. If
known, the scheduled off-air periods for maintenance will also be given in local time and
date.

3.4.1 Locate .............. Displays the Survey Planner dialog box. Input boxes are
provided for entering latitude, longitude, and local time zone.
The Time Zone Map button loads a world map with time
zones onto the screen. The Transmitters button provides a
detailed listing of all transmitters within 7000 km. 

To save a copy of the listing to a default file named 
“temptx.dat”, select Copy from the menu bar. The Return button
clears the screen and returns to the Main Menu.

The following information is presented on the tabulated transmitter listing:

Code Three digit station identification code
Freq kHz Transmitter frequency in kilohertz
Station, Country Station name and host country
Powr kW Power output in kilowatts
Sched. Off This is the regularly scheduled time and day that the 

transmitter will most likely be off the air for maintenance
and repairs etc. relative to the local time of the survey site.
If the schedule is unknown, 0-0 will be displayed.

Dist km Distance in kilometers between the survey site and the
transmitter.

Dir deg The bearing (0-360) to the transmitter relative to true
(geographic) North.

Range km This is the estimated effective range of the transmitter (in
kilometers). The range calculation is based on an empirically
derived equation that uses power output and the modeling
results of Hauser and Rhoads (1974).
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3.5 Wadi

The Wadi download module provided with this software is contained in the executable file
called WADIDL.EXE. It is used to transfer data from the Wadi to a PC through the serial
port. This is a stand-alone program and can be started two different ways: it can be
initiated from within the RAMAG program by selecting [Wadi] / [Data Transfer] or it can be
run independently by double clicking on WADIDL.EXE. You can also use the run command
in the Windows Startup menu. Type c:\ramag2\wadidl.exe then <Enter>. If RAMAG is
running on an older laptop or desktop with limited memory, it is recommended that
WADIDL.EXE be run independently to avoid possible out-of-memory errors.

3.5.1 Data Transfer............. Starts the down-load module which transfers data from
the Wadi to the host computer using the RS232 port.

On-screen instructions are provided that guide the user through the transfer process from
beginning to end.  A summary is provided below.

Initial Steps:
1) Connect the Wadi to the computer serial port (Com1, 2, 3, 4) using the interface cable.
2) Turn on the Wadi
3) Start RAMAG and select [Wadi/Data Transfer] from the Main Menu. Click [UserInput]
    on the Wadi down-load menu bar. This opens the User Input window. Enter the   
        filename and file header, then select the appropriate Com Port. Click OK to accept

or Cancel to abort.
4) On the Wadi: Press the [::] button two times for a listing of stored profiles. Enter the   
  profile to be down loaded next to the word Coordinate: 

Example:  Coordinate: 100->     where 100-> is the profile designation.
5) Click the Start button on the computer screen to initialize transfer.
6) On the Wadi: Press F => 1, F 2   to start sending the in-phase (real) data. The =>

symbol represents the large green arrow. The raw data will be displayed line-by-line
in the Com Port window.  The computer speaker beeps when transfer is complete.

7) On the Wadi: Press F => 3, F 2   to start sending out-of-phase (imaginary) data.

When transfer is complete, a User Input dialog box displays the following:

Do you want to:
1) Down-load another file to the Active File
2) Open a new Active File for data transfer
3) EXIT program

Enter (1, 2, or 3)

Entering 1 allows the user to add another profile to the currently open data file. Steps 4,
6, and 7 are then repeated.
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Entering 2 closes the active data file and prompts the user to click the [UserInput] menu
item again and enter a new file name and file header. If the Wadi contains data from
several different survey sites, this allows the data to be stored in separate files. Steps 4-7
are then repeated.  

Entering 3 terminates the data transfer process, closes the down-load screen  and returns
to the RAMAG Main Menu.

3.6 Close Graph

3.6.1 Close ............... Closes the graph window and releases memory.

3.7 Quit

3.7.1 Quit Program ..... Exits the Ramag program and returns to the Windows
operating system.

4. Graph Menu

The graph window is a sub-window that fills the main program screen when Unfiltered,
Filtered, or Cross Section is selected from the Plot Menu. A separate menu bar is used to
manipulate the contents of the graph window. A description of the graph pull down menus
is provided below.

4.1 File

4.1.1 Save As Metafile Saves a line graph as a Windows Metafile. The user is
prompted for a filename. Current density cross sections cannot
be saved as Windows metafiles. To save cross sections as
Windows bitmap files see Sections 3.3.1 and 3.3.2

4.1.2 Print Current Page(*) Sends a copy of the graph to the currently installed
printer. (Select Print Setup first)

4.1.3 Print Selected Graph(*) Currently the same as 4.1.2. In future versions, a
page may contain more than one graph that can be printed
separately. (Select Print Setup first)

4.1.4 Print Setup(*) ........ Displays the printer dialog box that allows the user to
change configuration settings of the currently selected
printer or to select a new printer.

4.1.5 Print Options ..... Displays a dialog box that allows the user to select various
printing options such as graph size and page position.
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Printing Note (*): Some Windows printer drivers need to be initiated prior to printing. In
RAMAG this is accomplished by selecting [File] / [Print Setup] from the graph menu. Simply
opening and then closing the Print Setup dialog box will initiate the driver and it will stay
active until the program is closed. 

4.2 Edit

Edit options, Copy Graph and Copy Page, are for line graphs only. Current density cross
sections will not copy properly to the Windows clipboard.

4.2.1 Copy Graph ....... Copies the graph to the Windows clipboard. This allows the
image to be pasted into other applications. (Line graphs only)

4.2.2 Copy Page ........ Currently the same as 4.2.1 (Line graphs only)

4.3 Graphs

4.3.1 Parameters ........ Displays the Graph Parameters dialog box that lets the user
change the position, size, color, and border attributes of the
graph. This editing option can also be activated by using the 
graph selector button (red square) in the upper right corner of
the graph.

4.3.2 Fill Page ............ Enlarges the graph window to fill the screen (default).

4.3.3 Delete Graph ..... Removes the graph from the graph window.

4.4 Options

4.4.1 Show Selectors... Both options are reserved for future versions where multiple
graphs may appear on one page.

4.4.2 Highlight Selected Graph Same as 4.4.1.

5. Interactive Graph Design

5.1 Types of graphical objects

A graph consists of a collection of graphical objects. The following object types can be
edited or changed by the user: axes, axes labels, axes titles, graph titles and text, graph
data and the line plot.
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5.2 Graphical object properties

Examples of object properties that can be changed are: color, line attributes (style, width,
color), font style and size for titles and labels, and spline smoothing for line graphs.

5.3 Selecting objects for editing

To edit a graphical object, it must be selected. This is done with the mouse arrow cursor.
If the cursor is positioned over a graphical object and the left mouse button is clicked, the
object will be highlighted by a blinking rectangular border. A double mouse click will briefly
highlight the object and then open the appropriate dialog box for editing that object.

6. Tutorial

Load a data file and view the profile information screen

Start RAMAG and select Load from the File Menu. The program looks for a folder called
c:\vlfdata that contains Wadi files. If this folder is not found it defaults to the currently active
folder.  Load the file EXAMPLE1.WAD and select profile 100W. Go to Data Info under the
File Menu to display a data information window. Data Set information pertains to the entire
group of profiles contained in EXAMPLE1.WAD. Profile information is relevant to the
selected profile, in this case 100W. This is useful for reviewing profile coordinates and line
lengths and for determining X axis limits for current density cross sections. Click Return to
close the window.

Plot unfiltered and filtered data using preset and interactive graphics

Select Unfiltered data under the Plot Menu. A plot window opens and displays a basic
line graph of unfiltered in-phase and quadrature data. Close the plot window by clicking
(CloseGraph/Close) on the Main Menu or by clicking the Windows close button [X] in the
upper right corner of the plot. Now select Filtered Data from the Plot Menu. The plot
window shows Profile 100W filtered at a depth of 60 ft, which is the default filter depth. 
To change the filter depth, go to Set Filter Depth under the Plot Menu.

Position the tip of the arrow pointer anywhere on the Y axis and double click. This opens
the vertical axis display box for editing. Click the check box next to Major in the Grids
Group, then click on the style button and change solid to dashed. Click OK, then OK again
to close the editing windows and update the filtered graph. The Y axis now ranges from -20
to 40 and dashed lines are projected across the graph at major tick intervals. Double click
the X axis and change the maximum to 250, then OK. The X axis is now 0 to 250.

Now move the arrow pointer to any point on the in-phase (dark red) line graph and double
click.  Click the Spline check box, then OK. The line graph is now displayed as a smooth
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spline curve. If you want to fill in the area below the curve with a solid color, return to the
curve editing box and check the Fill Area option.

Double click the data curve again and select the Data button. Here the filtered data can be
edited and  revised. To edit the raw data, first display an Unfiltered graph. To send a copy
of the edited data to the Windows clipboard, select the Copy button.

Any of the graph titles or axis labels can be edited by double clicking on the text. For
example, change the Example title to a bold font. Close the graph window.

Viewing current density cross sections in color and grey scale

Select Cross Section under the Plot Menu. Accept the default axis limits of 0 and 250.
Cross sections are limited to 300 data units (ft or m). If profiles are long, use the x axis
limits box to specify which section of the profile is to be used for filtering. Click OK to
display the cross section in color. The display shows two shallow conductive anomalies
that merge at a depth of 50-60 feet.  Close the graph window and return to the Plot Menu.
Change the filter depth to 70 feet by selecting [Plot] / [Set Filter depth]. Also, select Change
Color under the Plot Menu and enter a 2 for shades of grey. Now display the cross section
again. Grey scale cross sections look good on laser printers and non-color ink jets.

At any time, you can print the line graph or cross section by choosing Print Setup under the
File Menu in the graph window. This will initialize the Windows print driver and allow print
orientation (portrait or landscape) and other properties to be set. See Print Setup and Print
Options in sections 4.1.4 and 4.1.5.

Multi-Profile Plots

First change the filter depth to 20 by selecting [Plot]To produce a stacked line plot of all
profiles in a data set, select Multi-Profile under the Plot Menu. Click the Graph button to
filter and plot the graphs. If the individual line graphs appear to overlap, they can be
adjusted by using the New Scale button. For the EXAMPLE data set, change the scale to
-50 50 and then click the Graph button again to re-draw. The maximum number of profiles
that can be displayed is 10.

Retreiving information from the Transmitter Data Base

Select Locate under Transmitters on the Main Menu. A survey site coordinates screen is
displayed showing input boxes for latitude, longitude, and time zone. If you are not sure of
the time zone, click the Time Zone Map button to display a scrolling map of the world.
Click the Transmitters button to accept the default coordinates for Fallbrook, CA. The
survey planner produces a listing of all transmitters within a 7000 km radius. One of the
headings on the list is Dir(degrees). This is the direction to the transmitter relative to true
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North and is useful in the field when laying out the survey grid so as to optimize signal
strength. The effective transmitting range and the off-air schedule (if known) in local time
is also provided. Select copy from the Menu bar to write a copy of the listing to a file called
“temptx.dat” in the default folder. This is an ascii text file and can be printed using the
Windows notepad program or any other text editor. Click Exit to close the listing window.
  
7.0 Transmitter data base

The RAMAG software is delivered with a worldwide VLF transmitter data base contained
in the file AUXDB.DAT. When new VLF transmitters are found or when information about
a known station change, it may be desirable to update the data base.

7.1 Updating the VLF transmitter data base

If you would like to add a new station, revise a station frequency or update the scheduled
off-air time or day, simply load the AUXDB.DAT file into a text editor, make changes to the
appropriate columns, save as AUXDB.DAT and copy the revised file back into the RAMAG
directory. 

7.2 VLF transmitter data base file format

The transmitter data base format used by RAMAG is shown below. The column
assignments must be strictly adhered to.

Example transmitter data base entry

NAA  24.0  Cutler,Maine,USA   1000  067W17  44N39  5600  1000-1800Mo  -5

Columns Example Description
1-3 NAA Station Code
7-10 24.0 Frequency in kilohertz
13-32 Cutler,Maine,USA Transmitter location, country
34-37 1000 Power output in kilowatts
40-45 067W17 Longitude (degrees/direction/minutes)
48-52 44N39 Latitude (degrees/direction/minutes)
55-58 5600 Transmitter range (if unknown, leave blank)
61-69 1000-1800 Off-air in Universal Time (blank if unknown)
71-72 Mo Off-air day of week (Mo Tu We Th Fr Sa Su)
75-77 -5 World time zone relative to Greenwich Mean Time

(West is -, East is +)
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8. Input data file format

Input data files for RAMAG can be created using any text editor. The VLF readings must
be entered as [distance coordinate, in-phase (real), quadrature (imaginary)] beginning on
line 5 and can be separated by a comma or, one or more blank spaces (no Tabs). The
distance coordinate must be an integer and should be negative for South or West
coordinates. If measurements were taken along a series of parallel profiles within the same
area, then all data should be entered into a single data file.

An example of a RAMAG data file is shown below. The comments are for descriptive
purposes only and are not part of the data file.

Boulder Ridge <-- Header title, columns 1-20
0000W <-- Profile ID, columns 1-5
21.4 <-- Frequency in kHz, columns 1-4
 21 <-- Number of data points along 0000W, columns 1-3
-50  41.7  5.8 <-- Distance, Real, Imaginary (space or comma delimited)
-40  35.2  5.8
-30  33.6  5.2
-20  37.0  8.1
-10  36.6  7.0 Important Note: When using a text editor to create a data
  0  20.6  3.4 file, make sure there are no blank lines beyond the last
 10  -4.5  0.7 data point, or "Error: Input past end of file"
 20  -12.2 2.4 will occur.
 30  -13.6 4.0
 40  -10.7 6.1
 50  -13.8 7.2
 60  -5.6  10.0
 70  -2.1  12.3
 80  -9.8  10.9
 90  -13.5 10.3
 100 -21.2 10.7
 110 -17.1 14.8
 120 -10.7 20.6
 130 -6.4  17.3
 140 -6.7  17.8
 150 -6.3  16.2
0030W <-- Next Profile ID
21.4 <-- Frequency in kilohertz
 26 <-- Number of data points along 0030W
 0  19.3  -4.7
 10  26.1  -0.3
 20  29.7  1.9  ... and so on for all profiles in the data set
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9. Interpretation Notes

The recommended way to use the RAMAG software is to download and plot line graphs
of the raw data, inspect the quality and look for signs of cultural noise and interference
from powerlines, buried pipelines, grounded metal fences and atmospheric magnetic
storms. Data that has a saw-tooth appearance should be considered suspect. If the data
looks good, then select areas for filtering at various depths and for producing current
density cross sections. Data units are in % In-phase, which is the percentage of the In-
phase response produced by the subsurface conductor (anomaly).

If you are exploring for water-bearing bedrock fracture zones or mineralized bedrock with
high conductivity, you should look for large positive anomalies on the filtered line graphs.
It is very important to understand the local geologic setting and to have an idea of the
strata and geologic structures that may be present beneath the surface. Examples of other
geologic features that can produce filtered anomalies (peaks) are mineralized contacts,
clay deposits, vertical conductive dikes, and fault zones with clay gouge.

There is no direct relationship between the colors on the current density cross sections and
the absolute detection of groundwater. Neither the Wadi or any other VLF instrument is a
water detector. These instruments simply detect and map electrically conductive zones in
the subsurface. The colors reflect the degree of conductivity. Red is very conductive, blue
is very resistive. Bedrock that is broken and fractured (more porous) and contains
groundwater is more likely to be electrically conductive than massive, hard, and
unfractured crystalline rock.

For a full discussion of the VLF method, case histories and how to use and interpret the
filtered graphs and current density cross sections see the Abem Wadi Instruction Manual
(Appendix A) and the Wadi Interpretation Guide - Theory, practice and case stories for
Wadi operators.

10. Error messages and solutions to common problems

The following error messages and problems are the most frequently reported by first time
users of the software. If you encounter an error that is not listed below, make note of the
exact wording and the sequence of events or steps just prior to error message. Send to the
e-mail address listed on the front cover of the Instruction Manual.

Error message: “Hardware key not found”

Solution: The security hardware key (dongle) is not attached to the USB port or is not
pushed in all the way. Check that the key is properly installed. The LED light on the key 
should be on if the software and key are properly installed.

Error message:  “Subscript out of range”
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Solution: Some clients attempt to edit or revise bad data points by loading the raw Wadi
files into a word processor or text editor. Many times the file is re-saved with the same
name but the original file format has been altered. Make sure the text editor does not alter
or reformat the file. Windows Notepad is recommended.

Common problem: “Files ending with .EXE, .DAT, .PDF are not seen on the RAMAG CD.”

Solution: The files are not missing. The reason you do not see them is that Windows
Explorer has been set to hide file extensions. To reconfigure you computer to show the
complete filenames, do the following: open Windows Explorer, on the menu bar click Tools
> Folder Options > View. Remove the check mark in the box next to “Hide extensions for
known file types”, then click the Apply button. You will now see all file types.
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